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The winter holiday season is upon us again. Around
our house, most of the holiday celebrations center
around the kids and making things as fun and festive
as can be for them.

Of course, around our house, that means putting up
a Christmas tree, decorating the outside of the
house with holiday lights, lots of holiday shows on
the television, making fudge and other favorite
Christmas candies, and making wish lists for Santa
Claus.

This year, my eight year old son has let us know he
wants a computer. He’s into playing Minecraft … A
LOT! He plays Minecraft on his Amazon Kindle
tablet. He plays a Minecraft clone game on “his
phone.” No, I did NOT get my son his own cell
phone.

“His phone” is my old Google Pixel 3 that my
wireless carrier wouldn’t take back on a trade-in
special they were running, because the LiON battery
had swelled and was on the verge of rupturing. So, I
brought it back home and bought a new battery and
waterproof seal off eBay for under $25. What did I
have to lose? I watched a couple of videos on
YouTube to figure out exactly what to do. To be
perfectly honest, the hardest part of the battery
switch was heating the back of the old phone with a
hair dryer to loosen the waterproof adhesive seal.
Now he has “his phone” to play his Minecraft clone
game on, instead of monopolizing mom’s phone.

He is convinced that the only way for him to run the
Minecraft Caves & Cliffs update is to be running
Minecraft on a computer. So he is dead set on
having a computer. He uses computers at school,
but never really touches the computers here at
home (and we have plenty scattered around the
house). Maybe if he has his own, it would be

different, though. I have to go on faith that it’s
something that he’ll use. The only other alternative is
to not get him his own computer, and he faces the
childhood devastation of not getting what he wanted
for Christmas. He already knows they cost quite a bit
of money. He told his mom when he first told her
about his wanting a computer that he knows that
they “cost too much money.”

As much as anything else, a part of him wanting a
computer is he wants to be like dad. As you can
imagine, I spend a considerable amount of time on

the computer every day, keeping up with emails,
researching and gathering information for magazine
articles, and working on the magazine every month.
He sees this, and he wants to emulate his dad.

Even when you think they aren’t watching their role
models, they are. This has become evident in so
many different areas. Ryan has his own tools, and
will gladly go fetch them to help work on projects
around the house. When he sees something that he
can fix, he goes and gets his tools to quickly take
care of whatever the problem is. One day, he saw
some nails poking out from the fencing around the
chicken run. He ran in and got his hammer so that
he could take care of the protruding nails.

When I’m not sitting in “my chair,” or when I’m not
home, Ryan runs to sit in dad’s chair. Simply
because it’s dad’s chair, and he wants to be like his
dad.

Just this year, both Ryan and his sister, Lexi, got to
go deer hunting with mom and dad in our deer
blinds. We had LOTS of safety discussions, and
discussions about what to expect, how to behave,
and how to be Q-U-I-E-T. Confident that the lessons
were heard, Lexi went with mom, and Ryan went
with dad (the image above). For their first time in a
deer blind, I have to admit that things went pretty
well. As you can imagine, hours of sitting there with
minimal movement and not talking were a bit hard
for them to pull off. Every once in a while, we’d have
to remind them to stop fidgeting (“don’t move so
much”), or to only speak in very soft, barely audible
whispers. Neither mom or dad saw any deer that
afternoon into early evening, but the excitement was
palpable. When Ryan made his first of two trips to
the deer blind, his walk was almost a run as he
hurried to get out to the blind with his dad. His

From The Chief Editor's Desk...
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determination and excitement to get to the blind was
clearly evident.

Having children has made me more conscientious
about being a better me. I want to set a good
example for my children. They are watching,
listening and learning. And I realize that I am one of
their most important role models. I cannot and will
not fail them in that respect.

**********

The artwork for this month’s cover was created by
Meemaw, and laid out by parnote.

**********

We wish you a happy holiday season. And, as usual
and until next month, we wish you peace,
happiness, serenity and prosperity … and continued
good health! Be careful out there!

Screenshot ShowcaseScreenshot Showcase

Like Us On Facebook!

The PCLinuxOS Magazine

PCLinuxOS Fan Club

Posted by brisvegas, November 1, 2021, running Mate.
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by Paul Arnote (parnote)

Whoa!

It’s really THAT time of year again!

How did it get here that fast?

With the Winter Holidays just around the corner, it’s
time again for the annual holiday gift guides by the
staff of The PCLinuxOS Magazine. As in years past,
we (The CrankyZombie, Meemaw and me) will
present our ideas for what we think will make
excellent holiday gifts for those on your holiday wish
lists. There will be no guarantee about availability of
any particular product (supply chain issues seem to
rule the headlines these days), the prices you might
pay (inflation is rearing its ugly head), or the
suitability of any product for any particular purpose.
All prices are expressed in U.S. dollars. Also, due to
government jostling, positioning, and import/export
restrictions, we cannot guarantee that any of the
items listed will be available to you in your specific
locale.

We have tried to include items in our holiday gift
guides for all price ranges, from very affordable to
“maybe-a-little-more-than-I-might-like-to-spend.”
Each of us have chosen 10 items that we think
PCLinuxOS users might like to buy for those on their
holiday gift lists, or maybe even for themselves.

With all of that mumbo-jumbo out of the way, let’s
dive into my holiday gift guide suggestions.

AstroAI 2 Pack 27” Snow Brush & Detachable
Deluxe Ice Scraper with Ergonomic Foam Grip
for Cars $19.99 Newegg.com

While there isn’t anything “AI” about these ice
scrapers and snow brushes, they do appear to be
well thought out. Much of the time, these items are
monstrous items that take up a lot of space inside
your car. But these combo ice scrapers and snow
brushes break down into two smaller pieces, and
then stow inside their own bag, helping to keep them
clean and in good condition for the times that you
need them. The brush features layered bristles, to
speed the sweeping away of snow. The ice scraper
features a fine scraping blade that won’t scratch
your windshield, and some aggressive “knuckles” on
the back of the ice scraper to help chip through even
the toughest ice buildup. Plus, you get two. You can
keep one back “in reserve” for later use, or put one
in each vehicle (if you’re like us, and have two
vehicles).

Husky 12/120 Volt Auto and Home Inflator
Home Depot $64.98

This inflator/air compressor will handle all of your
needs around the home and in your vehicle. This
inflator can plug into your regular 110V household
electrical outlet, or you can plug it into the 12V
accessory outlet in your vehicle. The unit has built in
storage in each end, storing the inflator line and the
AC cord in one end, and the 12V accessory cord
and the included accessories in the other end. The
included accessories include a mattress nozzle, two
sports needles, and a presta valve adaptor. The
inflator really shines in its use with your vehicle to
keep your tires inflated to their proper inflation
pressure. Simply plug in the 12V power line into your
12V accessory outlet, then set the desired pressure
you want to inflate your tires to. Attach the inflator
hose and wait while your tire is inflated to your
desired pressure. The unit will automatically turn
itself off when it reaches your set pressure.
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http://www.commandlinefu.com
http://www.fsf.org
https://www.newegg.com/p/0W6-018H-00012?Item=9SIB1GHFNK1337&utm_medium=Email&utm_source=ShellShocker&cm_mmc=EMC-SD112021-_-SD11102021-_-Item-_-9SIB1GHFNK1337&tp=i-1NHD-Q7H-1Hk-7Oq0vg-2G-BKAt-1c-Gn1-6crc64-l6lj01ITUv-1zxWJL&om_rid=6779958520&om_mid=4944&email64=cGFybm90ZUBnbWFpbC5jb20%3d
https://www.homedepot.com/p/Husky-12-120-Volt-Auto-and-Home-Inflator-HD12120B/303815464
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Craftsman Extreme Grip 10" Adjustable Wrench
Amazon.com $24.99

If you’ve ever used a “regular” crescent wrench, you
know how frustrating it can be. Of course, the
convenience of a crescent wrench is that you have
one wrench that fits many sizes of bolts and nuts.
While better than nothing, a regular crescent wrench
constantly needs adjusting to maintain a firm, snug
grip on the nut or bolt you are trying to use it on. The
lack of a firm, snug grip on the nut or bolt means you
could very easily round off a nut or bolt, making it
next to impossible to loosen. Well, this Craftsman
version marries the convenience of a crescent
wrench with the firm, snug grip of locking pliers. As a
result, this version has twice the gripping power of a
regular crescent wrench. Because it’s adjustable, it
fits metric or SAE bolts/nuts up to 1” (2.54cm) in
diameter. In addition, they have added a comfort grip
that helps improve your grip on the tool.

Zippo Refillable Hand Warmer
Amazon.com $17.62

I know I’ve included disposable hand warmers in my
holiday gift guide before. But if you want true value,
invest in one (or more) of these refillable hand
warmers. These things have been around for well
over 50 years, and continue to perform well. You fill
the hand warmer with hand warmer/lighter fuel, then
light it. The filament burns the vapors without an
open flame, and produces heat for up to 17.5 hours.
When it runs out of fuel, simply refill it again. The
hand warmer comes with a soft bag to slip into. Then
slip that into your coat pocket. You won’t believe the
warmth. So, if you (or someone you know) spend
some time in the outdoors during cold weather, this
will be a highly appreciated gift.

APEXEL Phone Photography Kit Flexible Phone
Tripod, Remote Shutter, 4 in 1 Lens Set,18X
Telephoto Lens, Fisheye, Macro & Wide Angle
Lens for iPhone Amazon.com $27.99

Today’s cell phones often sport some pretty fancy
and advanced cameras. But you can get even more
from your cell phone’s camera by adding in this
photography kit. Yes, you can “zoom in” with your
cell phone, but that is usually just a digital zoom that
sacrifices image quality significantly. The addition of
one of these auxiliary lenses uses an optical solution
to help preserve image quality. This kit comes with a
tripod for your cell phone, a remote shutter trigger, a
fisheye lens, a wide angle lens, a macro lens for
extreme closeups, and a 18X telephoto lens. So add
a new level of creativity to your cell phone photos,
and leverage the high quality camera built into your
cell phone with the addition of this photography kit. If
nothing else, it will add another level of fun to your
cell phone pictures.
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https://www.amazon.com/dp/B00X0IYM08/?coliid=I2L3NWJIBYRFRI&colid=1SOCHSAK67RAE&psc=1&ref_=lv_ov_lig_dp_it
https://www.amazon.com/dp/B013HLGTL2/?coliid=I1CRAXPRBSSN84&colid=1SOCHSAK67RAE&ref_=lv_ov_lig_dp_it&th=1
https://www.amazon.com/dp/B0798H1YYF/?coliid=INIQ2T7XNW4JL&colid=1SOCHSAK67RAE&ref_=lv_ov_lig_dp_it&th=1
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Greatlizard S89 Mini Drone Foldable WiFi FPV
Drone With 4K HD Camera For Adults, RC
Quadcopter With 3D Flip, Headless Mode,
Altitude Hold, One Key Return, Bag And 3
Batteries Newegg.com $69.99

If you’ve ever thought about exploring flying your
own drone/UAV (unmanned aerial vehicle), this may
just get you up off the couch. This Greatlizard drone
features dual cameras, 4K video, a remote,
smartphone control, three 3.7v 1800 mAh batteries,
two replacement blades, a carrying case, and more.
A 60 minute charge of the batteries will get you
roughly 12 minutes of flight time, per battery. This
drone is listed as having “one touch” takeoff and
landing, so the most perilous parts of flying the
drone are handled for you. All you have to do is
touch the button on the remote or the phone app,
and it either takes off or lands. If you are using the
phone app to control the drone, you can set a
flightpath or multiple points in the area for your
drone to visit during its flight. Just draw the flightpath
on the screen of your phone, and the drone will
follow. This drone is listed as being for beginners,
and with a price of only $70, how could you possibly
go wrong?

WD Blue 3D NAND 1TB Internal SSD - SATA III
6Gb/s 2.5"/7mm Solid State Drive
Newegg.com $89.99

Do you want to give your PCLinuxOS computer a
real speed boost? And I mean a REAL speed boost
to faster than when you bought it? Or maybe your
computer is getting a little long in the tooth, and you
want a way to make it last even longer by giving it a
fresh breath of life? If so, replace your computer’s
hard drive with a solid state drive, or SSD (but only
after backing up your current hard drive … we
wouldn’t want to lose any of our personal files!). You
won’t believe how fast your computer boots, and
how much more responsive it is overall. Prices for
internal SSDs are currently running right around
$100 per TB of storage, while external SSDs are
currently running right around $140 per TB of
storage. That is, at least, what I’ve noticed about
how the prices are trending. As for what to do with
your hard drive you took out of your computer? Buy
a USB external case (most can be bought for under
$20), put your old hard drive in it (the whole process
takes about five minutes) and use it for external
storage. Of course, by replacing your HD with a
SSD, you’ll probably have to reinstall PCLinuxOS,
but you will be amazed at how fast PCLinuxOS
installs to a SSD. Plus, you’ll have a fully up-to-date,
clean installation of PCLinuxOS on your computer!

PCLinuxOS Men's & Women’s Baseball Tees
CafePress $33.99 (Men’s)/$29.99 (Women’s)

Show your love for your favorite operating system by
wearing these PCLinuxOS logo-emblazoned
baseball tees! Featuring a 60/40 blend of combed
cotton and polyester, these shirts will wear well with
minimal shrinkage (of course, if you’re in doubt, you
can order one size larger). These tees feature ¾
length sleeves, and are available in a combination of
colors. Plus, you’ll help spread the word about the
best Linux distro in the universe! In addition, a
portion of each sale from the PCLinuxOS Store on
CafePress goes to help provide financial support
that’s necessary to keep developing PCLinuxOS.

PCLinuxOS Journal CafePress $9.49
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https://www.newegg.com/p/380-00AG-00028
https://www.newegg.com/western-digital-blue-1tb/p/N82E16820250088
https://www.cafepress.com/mf/37022118/wh_baseball-jersey?productId=456230487&sizeGroupId=42&colorGroupId=3&attribute=0&fromProductId=456230476&fromProductIsPersonalized=false&fromColorNo=26&fromColorDescription=Navy&fromSizeNo=7&fromSizeDescription=X-Large&fromAttributeDescription=NA&fromAttributeValue=0&fromProductTypeNo=1452
https://www.cafepress.com/mf/37022118/wh-long-sleeve_long-sleeve-tshirt?productId=456230369&colorGroupId=9&attribute=0&fromProductId=456230370&fromProductIsPersonalized=false&fromColorNo=9&fromColorDescription=Red&fromSizeNo=4&fromSizeDescription=Small&fromAttributeDescription=NA&fromAttributeValue=0&fromProductTypeNo=1400
https://www.cafepress.com/pclinuxos.456230342#
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I know you’ve heard this advice before: keep a
notebook near your computer to jot down useful
commands you might need in the future. Well, a
PCLinuxOS Journal would make that perfect
notebook to do that with! Measuring 5x8 inches, you
have a choice (when you check out) of blank, lined,
dot grid, or task page sheets. Plus, a portion of each
sale from the PCLinuxOS Store on CafePress goes
to help provide financial support that’s necessary to
keep developing PCLinuxOS.

Help Provide Financial Support For PCLinuxOS

Unlike other Linux distros, PCLinuxOS does not
have the financial backing of famous, very wealthy
benefactors. PCLinuxOS also doesn’t have any
corporate sponsorship. Instead, PCLinuxOS relies
almost entirely on the generosity of its users. There
are costs involved (server space, electrical costs,
sustenance for its main developer) in making
PCLinuxOS available for your use. PCLinuxOS is
offered up for free (as in beer) for anyone who wants
to use it. So, instead of buying that overpriced virus-
magnet commercial operating system, you get a
much more stable and secure operating system for
free. So, how about sending over some of that
money you might have otherwise spent on that
commercial operating system (and for each program
you might need to be productive) to support and
sustain the development of PCLinuxOS. There are
multiple ways to contribute. Via the PCLinuxOS
GoFundMe page, you can donate whatever amount

you can afford. Or, by way of GumRoad, you can
make a one time donation, or an ongoing monthly
donation (see below). You can make your donation
either in your name, or in the name of your gift
recipient.

or

PCLinuxOS $5/Mo Donation
PCLinuxOS $10/Mo Donation
PCLinuxOS $25/Mo Donation

PCLinuxOS $5/Yr Donation
PCLinuxOS $10/Yr Donation
PCLinuxOS $25/Yr Donation
PCLinuxOS $50/Yr Donation

Summary

I’m sure that between the holiday gift suggestions
from me, The CrankyZombie and Meemaw, you will
be able to find that special gift for those on your
holiday gift list, or even something for yourself!

Happy Holidays!

Users Don't
Text

Phone
Web Surf
Facebook

Tweet
Instagram

Video
Take Pictures

Email
Chat

While Driving.

Put Down Your
Phone & Arrive Alive.

Looking for an old article?
Can't find what you want? Try the

PCLinuxOS Magazine's
searchable index!
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https://pclosmag.com/searchpclosmag.html
https://www.gofundme.com/f/support-pclinuxos
https://www.gofundme.com/f/support-pclinuxos
https://gumroad.com/l/FGqC
https://gumroad.com/l/zpNB
https://gumroad.com/l/MPxaN
https://gum.co/mMhE
https://gum.co/kATd
https://gum.co/McTK
https://gum.co/MajE
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by Meemaw

I probably say this every year, but it really does
seem like time has flown since last December!
Shopping for holiday gifts has probably been going
on a while for many people, but I always seem to
wait until November. Even then, I’m sometimes at a
loss. What do you get for a person who already has
plenty? Kids are pretty easy to buy for, because they
grow out of clothes and should have more advanced
books to read as they get older… but what do I buy
for my grown children who are used to going out and
getting what they need? While I’m at it, what do I
buy for my friend who is nearer my age? (I’m a MLU
in the forums - a Mature Linux User.) Let’s look at
some options. I might pick some things from some of
my favorite places to shop (Bits & Pieces, Newegg
or Bass Pro Shops).

Projection Weather and Date Clock
$19.99 at Bits & Pieces

This clock has the time, obviously, but also has the
temperature and humidity. It also has an alarm if
needed. The thing that sets this apart from other
clock/weather combos is that the time can be
projected on the ceiling or wherever you want it with
just a turn of the projection piece.

Wind Spinners
$49.99 to $129.99 at Bits & Pieces

A friend of mine has a wind spinner in her yard, and I
love watching it! I want one for my own yard now. I’ll
have to say that you can get one in your price range,
depending on how much you want to spend. If you
go to the site, they also have smaller wind spinners
and even hanging wind chimes for lower prices. The
one on the left above is $79.99 and the one on the
right above is $129.99.

Cats Gone Bad! $9.95 at Bits & Pieces

This is a book of true stories about cats! Fluffy Butt
would probably get some bad ideas! From the site,
“In 1924, a Labrador was sentenced to life in
Pennsylvania Penitentiary for murdering the
governor's cat! From funny felons to cat burglars to
the just plain naughty. In 2012, a couple in Seattle

called the police for help after their ferocious feline
cornered them in their bedroom!"

Around The Tree Train Set $20.99 at Newegg

I found this in the Clearance Sale section, so I don’t
know how long it will be available, but I thought it

Meemaw's 2021 Holiday Gift Guide

https://www.bitsandpieces.com/
https://www.newegg.com/
https://www.basspro.com/shop/en
https://www.bitsandpieces.com/product/projection-weather-and-date-clock
https://www.bitsandpieces.com/category/large-wind-spinners
https://www.bitsandpieces.com/product/cats-gone-bad-book
https://www.newegg.com/ibasetoy/p/028-0A7G-00001?Item=9SIAZ8BFU53327
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was really cute. It has a “retro” engine which makes
“real” train sounds, 3 cars to attach to the engine
and tracks that snap together to a 59”
circumference. Also included are 4 straight tracks
that can snap in to make the track oval.

Tinker Toys $29.99 on Bass Pro Shops

Wow, I haven’t seen Tinker Toys in a while! To be
honest, I haven’t done a lot of toy department
searching. These are advertised as the classic
Tinker Toys. From the site,

• Includes 100+ of your favorite TINKERTOY parts,
including spools, rods, and flags
• 15 unique building ideas to get the fun going
• Nostalgic collector's tin provides storage
• Makes a great gift for ages 3 and up

Power Inflator $69.00 at Home Depot

This is a handy inflator to have if you need a tire
aired up and aren’t close to a service station. I have
a compressor at home, but if you aren’t home, it’s

handy to carry in your vehicle as long as you keep
the battery charged. From Home Depot’s site:

“The cordless convenience allows for use in virtually
any location, such as tight spaces or corners, high
pressure applications such as sports balls, or in the
driveway. The included battery provides extreme
weather performance to withstand frigid weather
conditions with fade-free power for maximum
performance. The charger included in this kit is
compatible with all RYOBI 18V ONE+ Lithium-Ion
Batteries.”

If Ryobi isn’t your favorite brand (many buy only one
brand, which is good because the batteries are
usually interchangeable between tools), Milwaukee
and DeWalt also make small inflators, but they are
bigger and carried with a handle. DeWalt’s is $284
with the battery, charger and the different connectors
(all sold separately), and Milwaukee’s is $297 with
the battery two-pack and charger.

Chefman Air Fryer $129.99 at Best Buy

Everyone’s talking about air fryers now. They are
very handy to heat up food or cook items without
immersing them in oil. Those who want to avoid the
oil use them a lot. The one shown above has racks
for lots of food. I have one and can cook meat on
one level and fries on another. In addition, this one
has the option to use a rotisserie (and came with all
the attachments for one). Smaller ones are available
that just have a basket to place the food in.

LED Candles $25.19 at Amazon

Meemaw's 2021 Holiday Gift Guide

https://www.basspro.com/shop/en/knex-tinkertoy-classic-100-piece-building-set-with-tin-100324377
https://www.homedepot.com/p/RYOBI-ONE-18V-Lithium-Ion-Cordless-Power-Inflator-Kit-with-1-5-Ah-Battery-and-18V-Charger-P737DKN/311788879?MERCH=REC-_-searchViewed-_-NA-_-311788879-_-N
https://www.bestbuy.com/site/chefman-chefmanmultifunctionaldigital-air-fryer-rotisserie-dehydrator-oven17cooking-presets-xl10lfamily-size-black-black/6414714.p?skuId=6414714
https://www.amazon.com/dp/B07X8R8P73/ref=cm_gf_aAN_d_p0_e0_qd3_bWWjJGwazdp6SexqkZWY?th=1
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Three grey glass containers, each with a flameless
candle. The set comes with a remote, used to set
the candles on a timer, or adjust the flicker and
brightness on the candles.

Sequence Board Game $15.95 from Amazon

From the site:
• Play a card from your hand, and place a chip on a

corresponding space on the game board - when
you have five in a row, it’s a SEQUENCE
• Each player or team tries to score the required

number of five-card SEQUENCES before their
opponents
• Easy enough for children, challenging for adults!
• Exciting gameplay develops STEM skills like

strategy
• For 2-12 players, ages 7 and up

We have this game and it’s wonderful for all ages.
This is the original board game, but is available in
jumbo and kid’s versions. The jumbo has a much
bigger vinyl mat ($49.11) and the kids version has
different artwork and uses pictures rather than card
faces ($17.99). You can also get it in a metal box
($29.99).

Tips for parents buying childrens’ gifts from
Frugal Fun 4 Boys & Girls. I found these tips for
gift-giving, and thought I would share.

Tip #1: Limit the number of gifts. This sounds so
obvious, but it’s easy to buy more than is needed in
the excitement of the season. Kids really don’t need
a lot of gifts to have a fun Christmas. In fact, too
many gifts can be overwhelming, especially for
toddlers and preschoolers.

Tip #2: Ideas for consumable gifts. Giving and
receiving gifts is a lot of fun! We want to encourage
our kids to be givers, and we have a tradition of
exchanging sibling gifts each year on Christmas
Eve. However, it’s very helpful in the clutter
department if at least some of the gifts given are
things like art supplies or edible treats. Here are
some ideas for gifts to give that are consumable.
• Drawing paper
• Paints/brushes
• Markers
• Gel pens – These are fun for both drawing and

coloring, especially with detailed coloring books
• Notebooks or journals
• Tape – never underestimate the joy of owning

one’s own roll of Scotch tape, with no one telling
you to stop wasting!
• Rubber bands – the boys find endless uses for

these!
• Duct tape
• Fun pencils
• Stickers
• Play dough
• Favorite snacks, especially things that are not

normally purchased
• Gift card for a restaurant or book store
• Parachute cord and supplies for making bracelets

Tip #3: Ideas for experience gifts.
• Experiences create memories rather than clutter

and mess! Why not give the gift of a fun
experience that you would not normally spend
money on?

• A musical instrument and/or music lessons
• A month of karate or gymnastics or swimming

lessons (indoors for this time of year, of course!)
• A coupon for a “date night” with just that child and

one or both parents – dinner out, etc.
• A horseback trail ride
• Movie tickets
• Tickets to a sporting event
• For the family – a family pass to the zoo or local

museum
• Symphony tickets or tickets to a play

Tip #4: Ideas for gifts that are not toys.
• Tool set
• Flashlights – these are always a hit!
• A camera
• Binoculars
• Clothes – if they have been wanting an item that

you haven’t bought because it isn’t a need, it
might make a fun gift!
• Books
•Wall calendar
• Accessories – hats, gloves, wallet, etc.

Tip #5: Open-ended toys that encourage creative
play.

Well chosen, open-ended toys can be worth the
expense (and the clean-up!). We really like toys that
are parts of a larger set such as wooden trains,
LEGO, Lincoln Logs, etc.

Also, for adults, ideas could include gift certificates
for a favorite restaurant or store, or a child could
give a parent a “coupon” for a special job that’s not
part of their normal chores. Another idea for those
with extended families who don’t want to spend
money on every single person could be to draw
names and just get one present each, or pool their
money and “adopt” a needy family in their area.

Happy Holidays!

Meemaw's 2021 Holiday Gift Guide

https://www.amazon.com/SEQUENCE-Original-SEQUENCE-Folding-Packaging/dp/B00000IVAK/ref=sr_1_1?crid=32OEUGGNR2Q0K&keywords=sequence+board+game&qid=1636692932&sprefix=sequ%2Caps%2C647&sr=8-1
https://frugalfun4boys.com/christmas-gift-ideas-for-a-clutter-free-christmas/
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by YouCanToo/The_CrankyZombie

Santa says, “Ho... Ho... Ho…”
It's that time of the year once again. So let’s get right
to it.

For those that are challenged by bread making now
you can make and bake it all in the same container.
Use it in the oven or the microwave.

Silicone Bread Baking Bowl Multi Oven Steamer
Loaf Bread Maker $18.88

Bring back fresh memories of yesteryear, and make
your own fresh cream butter (center, top).

Kilner Butter Churn $39.95

Enjoy delicious, homemade bacon for breakfast,
lunch and dinner! Contains everything you need to
make 5 pounds of bacon in the convenience of your
home.

DIY Bacon Curing Kit $27.95

Make your instant pot do double duty. Turn it into an
air fryer. Fits the 6 or 8 quart Instant Pot.

CrunchLid by SousVideArt $79.99

David's Top 10 Holiday Gift Picks

https://www.walmart.com/ip/Silicone-Bread-Baking-Bowl-Multi-Oven-Steamer-Loaf-Bread-Maker-Food-Cooking/258283635?wmlspartner=wlpa&selectedSellerId=101084160&&adid=22222222227489157983&wl0=&wl1=g&wl2=c&wl3=540610586059&wl4=pla-1409538329010&wl5=9032995&wl6=&wl7=&wl8=&wl9=pla&wl10=451105094&wl11=online&wl12=258283635&veh=sem&gclid=Cj0KCQiAsqOMBhDFARIsAFBTN3cSlcS7rXyyHR26yXXp0XgNVch6D-3_nu15O23OVFuG2ujBhlUbWTEaAtR3EALw_wcB&gclsrc=aw.ds
https://www.wayfair.com/Kilner--Create-and-Make-Glass-Butter-Churn-0025.348-L1056-K~KLNR1000.html?refid=GX528945731443-KLNR1000&device=c&ptid=1030705487958&network=g&targetid=pla-1030705487958&channel=GooglePLA&ireid=72399499&fdid=1817&gclid=Cj0KCQiAsqOMBhDFARIsAFBTN3cTB6CqR4_RKGPjzc__0VdK0-eU-lw6tyHLhNgdd3u_4cP7mp0swb8aAo1-EALw_wcB
https://www.thegrommet.com/products/original-bacon-kit-diy-bacon-curing-kit
https://www.amazon.com/Air-Fryer-Instant-Pressure-Cooker/dp/B08941ZHKG/ref=sr_1_1_sspa?keywords=air+fryer+lid+for+instant+pot&qid=1636430926&sr=8-1-spons&psc=1&smid=A2JAJ2FWLYPV7Z&spLa=ZW5jcnlwdGVkUXVhbGlmaWVyPUEyMkI4NjlQSEZLUTBGJmVuY3J5cHRlZElkPUEwNTI2MDM0MVM2NUJDUVc1MFBIMyZlbmNyeXB0ZWRBZElkPUEwNjkyMTU1M0NHVTRKTkhaWUQ1SSZ3aWRnZXROYW1lPXNwX2F0ZiZhY3Rpb249Y2xpY2tSZWRpcmVjdCZkb05vdExvZ0NsaWNrPXRydWU=
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For the Budding Brewmaster.

Craft beer. It's not just for mom and dad anymore.
We're talking about root beer, of course. And now
your little foodie can make their own at home.
Includes ingredients needed to brew up a fresh
batch of root beer (previous page, bottom right)

DIY Root Beer Science Kit $18.00

Ah, nostalgia. Give yourself a double dose with this
grown-up, just-for-you version of one of childhood's
greatest gadgets: the reel viewer. Assemble
snapshots of your favorite memories and add them
to your very own reel.

Create Your Own Reel Viewer $29.95

For the photographer in your life, or Fluffy Butt
himself.

Funny Mug Black Coffee Mug $14.99

When no regular old band aid will do.

Bacon Strips Bandages $9.09

Bring a little warmth and a lot of fun hiking, camping,
glamping, to the beach, on picnics, to the backyard
patio, to tailgates, on RV adventures and road trips,
or anywhere else you’d want to gather around a
bonfire.

Portable Campfire $29.99

Satsuki Azalea bonsai have been grown in Japan for
centuries and are widely considered the premiere
variety for this use. They bloom later in the spring
than other types; producing generous quantities of
bright pink blossoms.

Satsuki Azalea Bonsai Tree $27.04

David's Top 10 Holiday Gift Picks

http://www.pclinuxos.com
https://www.uncommongoods.com/product/diy-root-beer-science-kit
https://www.uncommongoods.com/product/create-your-own-reel-viewer#474350000003
https://www.amazon.com/People-Things-Coffee-Office-Ceramic/dp/B09KZLPXHP/ref=sr_1_242?keywords=I%2Bshoot%2Bpeople%2Bcoffee%2Bmug&qid=1636439810&sr=8-242&th=1
https://www.amazon.com/Accoutrements-11476-Bacon-Strips-Bandages/dp/B000SSV8AA/ref=sr_1_2?keywords=Bacon+Bandages&linkCode=sl2&linkId=bda0b35c324ddb01715dea21674d843f&qid=1636441289&qsid=143-4266142-2547906&sr=8-2&sres=B000SSV8AA%2CB07B6T8B4S%2CB00VY1CW78%2CB07B6V98SN%2CB08KFJT3XB%2CB015LYSQJ6%2CB00BPWU3SQ%2CB001DD88HK%2CB08JH93SHW%2CB08XWPML9Z%2CB00596VALS%2CB00570JWGQ%2CB08R5PMKTT%2CB0734JQYL8%2CB08JH8ZTBT%2CB01N6T0XHP%2CB07SY8G16W%2CB01BT3U6DW%2CB0963VH1VG%2CB07K88L3Z3&srpt=WOUND_DRESSING
https://www.amazon.com/dp/B073QXYW38?linkCode=ogi&tag=goodhousekeeping_auto-append-20&ascsubtag=[artid|10055.g.38170847[src|[ch|[lt|
https://www.amazon.com/dp/B07RPYPNDQ?linkCode=ogi&tag=goodhousekeeping_auto-append-20&ascsubtag=[artid|10055.g.38170847[src|[ch|[lt|sale
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Screenshot ShowcaseScreenshot Showcase
Podcasts For
Linux & BSD

Posted by mdiemer, November 24, 2021, running LXDE.

https://www.jupiterbroadcasting.com/show/linux-action-news/
https://www.jupiterbroadcasting.com/show/linuxun/
https://www.jupiterbroadcasting.com/show/techsnap/
https://www.jupiterbroadcasting.com/show/headlines/
https://www.jupiterbroadcasting.com/show/choose/
https://www.jupiterbroadcasting.com/show/bsdnow/
https://www.jupiterbroadcasting.com/
http://www.pclosusers.com/services-signup.php
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by Meemaw

We’ve done several text effects in Inkscape, but I
don’t think we ever did any speckled text. I found it
on GoInkscape. It’s kinda fun, so let’s do it.

After opening your Inkscape, click the Ellipse tool,
and draw a 3px by 3px circle.

Making sure it is selected, click Edit > Clone >
Create Tiled Clones. Keep all the settings standard
except what’s below.

You should get something similar to the figure below.
Select them all and Group them.

Next, choose your Text tool and type some text.
Make sure to Path > Object to Path the text
afterwards.

The letters are grouped, so double-click on one of
them to enter that group. Now you can select all the
letters by outlining them with your cursor. Each one
will be inside its own selection box. Click Path >
Outset a couple times to thicken the letters.

We need another copy of our speckled background,
so copy and paste our group of dots. Change this
copy to another color.

Select the text and the first group of dots. Line them
up with the text on top. Click on Object > Clip > Set.
You should have that speckled text effect.

Finally, position the speckled text over our second
group of dots. (This step is optional.) Use Object >
Align and Distribute to make it perfect.

Another thing I did was make a copy of the text with
a 1 px dark grey stroke and a white fill, and layered it
between the speckled text and the speckled
background. It kind of brings out the edges of the
text.

Donate NOW

Inkscape Tutorial: Speckled Text

http://www.gofundme.com/pclinuxos-2016
https://goinkscape.com/cool-speckled-text-effect/
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Serves about 8
Unit converter

INGREDIENTS:

2 cups coarsely chopped deli rotisserie chicken
2 cups chopped fresh baby spinach
1 jar (15 oz) Alfredo pasta sauce
2 cups shredded mozzarella cheese (8 oz)
1 can (16.3 oz) Pillsbury GrandsTM Southern
Homestyle refrigerated Buttermilk biscuits (8
biscuits)

DIRECTIONS:

1. Heat oven to 350F. Spray 13x9-inch (3-quart)
glass baking dish with cooking spray.

2. In a large bowl, mix chicken, spinach, Alfredo
sauce and 1 cup of the mozzarella cheese. Separate
dough into 8 biscuits; cut each into 6 pieces. Add to
the bowl; gently stir.

3. Spoon mixture into baking dish; top with
remaining 1 cup cheese.

4. Bake for 36 to 40 minutes or until deep golden
brown and biscuits are cooked through.

TIPS:

An easy way to cut the biscuits is with
kitchen scissors.

Pair up with a quick salad, and dinner is
done!

NUTRITION:

Calories: 510 Carbs: 32g
Fiber: 0g Sodium: 1050mg
Protein: 23g

Want To Help?
Would you like to help with the PCLinuxOS
Magazine? Opportunities abound. So get
involved!

You can write articles, help edit articles, serve
as a "technical advisor" to insure articles are
correct, create artwork, or help with the
magazine's layout.

Join us on our Google Group mailing list.

PCLinuxOS Recipe Corner

5-Ingredient Chicken Alfredo Bubble-Up Bake

http://www.linuxquestions.org
http://groups.google.com/group/pclinuxos-magazine
https://www.digitaldutch.com/unitconverter/volume.htm
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Screenshot ShowcaseScreenshot Showcase

It's easier than E=mc2

It's elemental
It's light years ahead

It's a wise choice
It's Radically Simple

It's ...

Posted by tuxlink, November 18, 2021, running KDE.

http://pclostalk.pclosusers.com
http://www.pclinuxos.com
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by Alessandro Ebersol (Agent Smith)

Gone are the days when Linux was synonymous
with frustration when it came to games. Ahh, no,
now we have so many games that, in a lifetime, I
doubt anyone could finish every game available for
Linux. We've come to this point thanks to companies
like Valve, which believed in GNU Linux to create
their new line of handhelds, SteamDeck, and
thereby boost video games on Linux. Not only that,
but Epic Games announced an anti-cheat module
for the Linux kernel, which could enable hundreds,
thousands of games that use anti-cheat features on
Windows. Yes, it's an admirable new world, and 20
years ago, who would have thought that things
would get where they are today?

So, let's review the options to buy PCLinuxOS
games this Christmas, and play a lot at the year-end
celebrations.

Steam, the biggest and best online store
specialized in PC games

Steam was created by Valve Corporation (Half-Life,
Counter-Strike, Team Fortress) and presents itself
as “the ultimate online gaming platform”. It is

certainly one of the most complete packages that
currently exist. You'll find over 70,000 titles (more
than you'd find in a physical store) and a community
of tens of millions of players (not an exaggeration).
There are other features like the mod workshops,
live streams, guides, forums, game swaps and a Big
Picture mode (where you can interact with the
interface with a game controller).

The Steam promotions are legendary! There are
several each year, usually in summer and winter, but
also during certain days (Halloween, Black Friday).
You can buy a large selection of games for cheap
prices.

Here's a list of Steam's pros and cons:

Pros

1. Games often go on sale. Due to several annual
promotions, AAA games go on sale at attractive and
affordable prices.

2. Access to a vast library of titles. Yes, more
games than one person could play in a lifetime.

3. Games are account based. If you switch
computers, you don't need to open another account,

your games in your Steam account will be available
to play on your new computer.

4. Unlockable Achievements in Games.
Achievements change the game, bringing a new life
to a title, with new skins, weapons and even
unlockable areas based on your in-game
achievements.

5. Streaming and Social Elements. It’s possible to
stream gameplays via the Steam platform and also
share screenshots, help in the forums, create
communities and more which is built-in on this
gaming platform.

Cons

1. Unfair practices of developers. One thing you
need to be aware of is shady developers. Some
people will try to pack any content (game assets)
and sell it to earn a dollar. You might see yourself
throwing money into a trash of a game.

2. Easily Manipulated Ranking System. Ranking
systems at Steam are easily manipulated. So again,
pretty much any ranking system on the Internet is. If
a group of people are unhappy with a company's
policies, you can be sure that their games will sink in
popularity.

3. Too much emphasis on card trading
exchange. I never got involved really in the idea of
Steam trading cards. I know some bad developers
were trying to corrupt the system while making a lot
of money from it.

4. Lack of company involvement to protect
players. Although Steam is getting better at
protecting players from shady developers, the
business still needs to do more. Right now, it's too

Online Game Stores For PCLinuxOS
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easy for the "creators" to rip off The Steam player
community with incredibly obscure practices.

5. Improve the Search Algorithm. I can't count the
number of times that I looked for a game that I knew
was on Steam only to see a “not found” on the
screen. Most of the time, I had to look for it in a
different way, with other search tools.

6. Last but not least, DRM. DRM does not have
many advantages for consumers. However, it is
useful to track the progress of your game, such as
through Steam trading cards and achievements.
These are associated with the steam account of a
user and are authenticated through DRM. However,
the risks and possible harms outweigh the benefits
in a staggering way: one of the biggest problems
with DRM is the exclusion of games from your
Steam account. If a platform like Steam removes a
game from your listing, you can't play it anymore,
since you only owned the license and not the game
itself. This license is void when the game is canceled
by Steam or the game publisher.

The Delisted Games website has a list of over 1,400
titles you can't currently download on your PC. Many
of these games include online titles that publishers
have discontinued, although there are also many
single-player titles. Also, in order to play your Steam
games, the Steam client must be running at all
times, to allow access to the Steam server and allow
the game(s) to run.

URL: https://store.steampowered.com/

How to install the Steam client on PCLinuxOS?

There is the usual way, which is to use the Steam
client via Flatpak, but our well-known friend Matt
Hartley made a video where he demonstrates how
to install the Steam client alternatively:
https://invidious.namazso.eu/watch?v=oaxXO0hlc8Y

GOG, one of the most user-friendly stores

Don't let its name fool you: Good Old Games not
only offers classics from other times, but is
constantly updated with the latest releases. Owned
by CD Projekt Red, game makers of such important
games as The Witcher, or Cyberpunk 2077, GOG
stands out from Steam for its sales policy without
anti-piracy protection. This feature is ideal if you
want to lend a game to a friend without any hassles.
GOG also has a 30-day refund policy, even if you
have downloaded, installed and played the game in
question.

Here is a list of pros and cons of GOG:

Pros

1. No regional restrictions. Regional restrictions
exist simply for the game publisher to get the best
price and maximize their profit. GOG has a price
only for the whole world.

2. DRM free. In second place, and most importantly
(and probably the most obvious), there is never any
DRM bundled with a GOG.com game or movie.
When I buy a title, I own it, I can download it as
many times as I want, and I can back it up to
whatever medium suits me, whether it's a pen drive
or CD, or DVD.

3. There is no client. Although GOG has introduced
the GOG Galaxy client, it is not mandatory, for you to
be able to play your games, it doesn’t need to be
running on the background, like the Steam client.

4. You get a lot more for your money. Games that
belong to your GOG.com account also come with
many extras - extras like soundtracks, in mp3
format, wallpapers, game art, as well as manuals
and other gifts.

5. Better client Support. GOG has better customer
support than most distributors. I wouldn't say it's the
best, but it's better than Steam and Origin, for sure.

There is also GOG connect, which allows users to
add games to their library, if they have purchased
them from another online store, such as Steam.

Cons

1. Game prices. Some might argue that the base
price of a game (lowest is $5.99) is too high. Some
games are overpriced, and selling prices aren't
always that spectacular. It is often possible to get the
same games cheaper elsewhere.

2. Bundles. I don't like the way games are
sometimes bundled together. For example, they put
Commands 2 and 3 in a bundle for sale instead of
selling them separately.

3. Missing expansions and incomplete series. It's
kind of annoying that some series are incomplete, or
that they lack game expansions and other goodies.
And to add to that, they are immensely slow to add
other games from a publisher's back catalogue.

4. Expanding their catalog. This may sound harsh,
but other distributors receive new games regularly.
It's probably because of how difficult it must be for
GOG to negotiate a deal, especially with larger
publishers, to get quick access to AAA titles.

Online Game Stores For PCLinuxOS

https://store.steampowered.com/
https://invidious.namazso.eu/watch?v=oaxXO0hlc8Y
https://delistedgames.com/
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5. More freeware games. GOG should have more
freeware games like Steam offers, have installers
and support for games that are very difficult to find
elsewhere. They should also consider hosting free
standalone games like The Dark Mod and
STALKER: Lost Alpha.

URL: https://www.gog.com/

How to install?

There is nothing to install. Just buy your games,
then download and play. It’s that simple.

Origin

The origin store is the official platform of EA
(Electronic Arts) and therefore has all of its popular
titles: The Sims, FIFA, Battlefield and more. In
addition to the possibility of a direct purchase, it
offers two subscription plans called EA Play (US$
5,00) and EA Play pro (US$ 19,00 ), which include
full and indefinite access to a collection of games
that is expanding over time, like a video game
version of Netflix. The catalog is smaller than on
Steam or GOG, but some of these games can only
be found on Origin.

URL: https://www.origin.com

How to install Origin client on PCLinuxOS?

The Origin client can be installed via Lutris.

Epic Games Store

Driven by Fortnite's overwhelming success, studio
Epic Games opened its own digital store in late
2018. While its game catalog can't compete with a
giant like Steam, the Epic Games Store has
managed to gain a prominent position in the market
thanks to its exclusive titles: Detroit: Become
Human, World War Z or the aforementioned Fortnite
- you'll only find them at the Epic Games store.

One thing that has helped the games' popularity
from Epic, is that they also give one or two games a
week. These can be easily found in the Free Games
section of their web store.

URL: https://www.epicgames.com/

How to install the client from Epic Games Store on
PCLinuxOS?

There is an unofficial Epic Games Store client,
Heroic Games Launcher.

Heroic Games Launcher is an unofficial Epic store
client for Linux. It is actually a GUI front-end to the

Legendary tool. Legendary is an open-source game
launcher that can install and run games from the
Epic Games platform on Linux and Windows.
However, until now there was no GUI for Legendary.

Another way to access Epic's store is through
Lutris.

The Indies Stores

Because Linux is not a mainstream operating
system (it wasn't, now it is), it attracted the attention
of many independent developers, who, of course,
were favored by independent stores as well.

Here follow some independent stores with games for
PCLinuxOS.

Humble Store

Humble Store works a little differently from others.
On the one hand, there is no PC application, and the
games you buy cannot be downloaded directly from
the store. Instead, you will receive a code where you
redeem your game on Steam, or another platform.
On the other hand, they offer so-called Humble
Bundles, which are bundles with several games that
you can buy at any price you like, starting with a
minimum amount, around US $1.00 (if you pay
more, you can expand the package). And as if that
wasn't enough, part of the money raised with each
purchase goes to a charity. The Humble Store also

Online Game Stores For PCLinuxOS

https://www.gog.com/
https://www.origin.com
https://www.epicgames.com/
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offers several subscription models, with which you
can choose up to 9 new games per month.

URL: https://www.humblebundle.com/store

itch.io

itch.io is a site for users to host, sell and download
indie electronic games. Launched in March 2013 by
Leaf Corcoran, the service has had nearly 100,000
games and items as of February 2018.

On March 3, 2013, Leaf Corcoran posted a blog
entry on leafo.net detailing what the site would be
like, with a Pay-As-You-Want template. In an
interview with Rock, Paper, Shotgun, Corcoran said
that the original idea was not a store, but rather a
place to "create a custom gaming homepage."

As of June 2015, the service hosted over 15,000
games and programs.

In December 2015, the service announced the
launch of a desktop application to install games and
other content. It was released with simultaneous
support for Windows, macOS and Linux. Today, the
Itch application is recommended as “the best way to
play your itch.io games”.

URL: https://itch.io/

Game Jolt

Game Jolt is a social community platform for video
games, gamers and content creators, which hosts
fan-run communities for over 1,644,492 games. The
platform is home to hundreds of thousands of
developers and gamers from all corners of the world
- from novice gamers to independent developers,
top notch influencers and some of the most
reputable studios in the industry. Game Jolt was
founded by Yaprak and David DeCarmine.

David started developing Game Jolt in 2002 at the
age of 14. His intention was to create a platform for
gamers where new independent games could be
discovered and quickly playable, and where
feedback could be provided directly to the creators,
allowing them to continue to improve their games.
On launch in July 2004, Game Jolt included a public
account system, game forums, a chat room and a
large game database, with each game downloaded
with the permission of the creators.

In December 2008, David launched a second
version of the site with Game Jolt becoming a
gaming portal. The site was redesigned and
introduced an automated system for uploading
games for download, as well as Flash, Unity and
Java games.

In January 2016, Game Jolt released the client and
frontend source code for the site on GitHub under
MIT license.

An online marketplace was announced in April 2016
and launched the following month in May, allowing
developers to sell their games on the site.

URL: https://gamejolt.com/

Honorable Mentions

The online stores listed below are not guaranteed to
work on PCLinuxOS, but if you want to take a risk…

Uplay Store: Official Ubisoft Store.

Google Stadia: Google Game Subscription Service.

Blizzard: The official store of Blizzard, creators of the
Diablo series.

Bethesda: The official store of Bethesda software,
owners of the Quake franchise.

So hopefully you have lots of online stores to visit,
and lots of games to play in the holiday season.
Happy Holidays and a great 2022, are the best
wishes from your friend Agent Smith (Alessandro
Ebersol).

Like Us On Facebook!

The PCLinuxOS Magazine

PCLinuxOS Fan Club

Online Game Stores For PCLinuxOS

https://www.facebook.com/The-PCLinuxOS-Magazine-292516664529821/
https://www.facebook.com/groups/2210485167/
http://pclinuxoshelp.com/index.php/Main_Page
http://www.fsf.org
https://www.humblebundle.com/store
https://itch.io/
https://gamejolt.com/
https://ubisoftconnect.com/
https://store.google.com/gb/product/stadia?hl=en-GB
https://www.blizzard.com/en-gb/?ref=www.battle.net
https://bethesda.net/
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by Paul Arnote (parnote)

The War On Your Privacy Monthly Update

ACCORDING TO A PRESS RELEASE FROM
EUROPOL, 12 INDIVIDUALS WERE ARRESTED
for their involvement with ransomware attacks
affecting over 1,800 people in 71 countries. These
individuals played a role in launching the
ransomware attacks against critical infrastructure.
The arrests occurred during the early morning hours
of October 26, 2021, in Ukraine and Switzerland.

From the press release:

The targeted suspects all had different roles in these
professional, highly organised criminal organisations.
Some of these criminals were dealing with the penetration
effort, using multiple mechanisms to compromise IT
networks, including brute force attacks, SQL injections,
stolen credentials and phishing emails with malicious
attachments.

Once on the network, some of these cyber actors would
focus on moving laterally, deploying malware such as

Trickbot, or post-exploitation frameworks such as Cobalt
Strike or PowerShell Empire, to stay undetected and gain
further access.

The criminals would then lay undetected in the
compromised systems, sometimes for months, probing for
more weaknesses in the IT networks before moving on to
monetising the infection by deploying a ransomware.
These cyber actors are known to have deployed
LockerGoga, MegaCortex and Dharma ransomware,
among others.

The effects of the ransomware attacks were devastating as
the criminals had had the time to explore the IT networks
undetected. A ransom note was then presented to the
victim, which demanded the victim pay the attackers in
Bitcoin in exchange for decryption keys.

A number of the individuals interrogated are suspected of
being in charge of laundering the ransom payments: they
would funnel the Bitcoin ransom payments through
mixing services, before cashing out the ill-gotten gains.

AN INAUGURAL TRUST ISSUES SURVEY BY
SAILPOINT TECHNOLOGIES FOUND THAT GEN
Z USERS WERE THE WEAK LINK when it comes
to online security, according to a press release.
While 59% of users were found to be using
corporate email addresses for online shopping and
other personal use, Gen Z users were the biggest
offenders, with 93% of Gen Z users admitting to
using corporate email addresses for personal use.
And when it came to the response to phishing
emails, 46% of Gen Z users said they would click the
link or open the attachment, compared to just 1% of
their older Boomer counterparts.

THE BLACKMATTER RANSOMWARE GROUP IS
CLOSING UP SHOP DUE TO INCREASED
PRESSURE FROM AUTHORITIES, according to an

article on TechRepublic. The group, which provided
“ransomware as a service” (RaaS), posted a
statement in Russian. Roughly translated, the
message read:

"Due to certain unsolvable circumstances associated with
pressure from the authorities (part of the team is no
longer available, after the latest news) – the project is
closed.

After 48 hours the entire infrastructure will be turned off,
it is allowed to:

Issue mail to companies for further communication

Get decryptors. For this write "give a decryptor" inside
the company chat, where they are needed.

We wish you all success, we were glad to work."

It is unclear from the message exactly what pressure
from authorities prompted the shutdown. It also
appears that some current victims of the
ransomware may never receive decryption keys,
especially if the attackers fail to download the
decrypters before the service is/was shut down.

A HACKER HAS ASSUMED RESPONSIBILITY
FOR EXPLOITING AN FBI EMAIL SERVICE TO
WARN OF PHONY CYBERATTACKS, according to
an article on TechRepublic. The hacker, who goes by
the name of pompompurin, sent phony emails from
the Law Enforcement Enterprise Portal (LEEP) to
illustrate a vulnerability in the FBI’s system. The FBI
uses the LEEP system to communicate with local
and state law enforcement officials. Until this
incident, just about anyone could apply for an
account on LEEP to communicate with the FBI. And,
ironically, the hacker obtained the passcode for
access by examining the HTML for the LEEP
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website itself. The FBI has since remediated the
software vulnerability.

If you’re a LinkedIn user, TAKE SOME TIME TO
FAMILIARIZE YOURSELF WITH SOME PHISHING
ATTEMPTS that try to appear as legitimate LinkedIn
emails, according to an article on TechRepublic. Pay
very close attention, because these faked LinkedIn
emails are typically very well done. Of course, if
you’re like me, you probably just delete or ignore
those “you appeared in 7 searches this week”
(legitimate) LinkedIn emails. In many of these faked
emails, the email address listed is NOT a LinkedIn
email address.

Yet Another 0-Day Exploit Found In Google
Chrome

It’s becoming as prevalent as the war on your
privacy. [SHOCK!] There’s yet another vulnerability
that’s been discovered in Google Chrome!
[/SHOCK!] According to Google’s “threat analysis
group” and reported on the Google blog, more

vulnerabilities have been uncovered in Google
Chrome. This time though, the vulnerabilities appear
to be limited to the Google Chrome running on
Microsoft Windows (I know you’re surprised!).
CVE-2021-21166 was discovered in February 2021
while running on Google Chrome 88.0.4323.182.
CVE-2021-3055 was discovered in June 2021 while
running on Chrome 91.0.4472.77.

Here’s how it worked, excerpted from the blog post:

Both of these 0-days were delivered as one-time links sent
by email to the targets, all of whom we believe were in
Armenia. The links led to attacker-controlled domains
that mimicked legitimate websites related to the targeted
users. When a target clicked the link, they were redirected
to a webpage that would fingerprint their device, collect
system information about the client and generate ECDH
keys to encrypt the exploits, and then send this data back
to the exploit server. The information collected from the
fingerprinting phase included screen resolution, timezone,
languages, browser plugins, and available MIME types.
This information was collected by the attackers to decide
whether or not an exploit should be delivered to the
target.Using appropriate configurations, we were able to
recover two 0-day exploits (CVE-2021-21166 & CVE-
2021-30551), which were targeting the latest versions of
Chrome on Windows at the time of delivery.

After the renderer is compromised, an intermediary stage
is executed to gather more information about the infected
device including OS build version, CPU, firmware and
BIOS information. This is likely collected in an attempt to
detect virtual machines and deliver a tailored sandbox
escape to the target. In our environment, we did not
receive any payloads past this stage.

Linux Kernel 5.15 Gets Improved NTFS Driver,
LTS Designation

On October 31, 2021, Linus Torvalds announced the
release of version 5.15 of the Linux kernel. Of
particular note is the merging of the NTFS driver into
the kernel. That driver came from Paragon Software,
and is their first submission to the Linux kernel. That
alone caused some anxiety, marking their first
voyage into what was uncharted waters for them.
Torvalds provided the nudge, and the code was
included into the kernel.

In other changes to the Linux kernel, according to an
article on The Register:

“Samsung's SMB3 file server ksmbd has also made it in,
described as "a new kernel module which implements the
server-side of the SMB3 protocol."
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Samsung said that it provides optimized performance, but
also that "the bigger goal is to add new features more
rapidly (eg, RDMA aka 'smbdirect', and recent encryption
and signing improvements to the protocol) which are
easier to develop on a smaller, more tightly optimized
kernel server than for example in Samba." ...

Another notable feature is DAMON (Data Access
Monitor) which originated from Amazon and which can
be used for advanced memory management optimization.

DAMON is designed to be accurate, lightweight and
scalable, and according to maintainer SeongJae Park,
mitigates "problems with [core] mechanisms" currently
implemented in the kernel."

Torvalds characterized the version 5.15 update as
relatively calm and small.

Say What?? Facebook Turns Off Facial
Recognition System

In an unexpected move, Facebook (now call me
Meta) has turned off its facial recognition program
for photos and videos, according to a Facebook
news report. Originally started in 2010, it was turned
on for everyone. In 2017, Facebook made it an opt-

in setting. The company says that it will stop
collecting facial recognition data, and delete the
templates it has used over the years to identify users
over the years.

In the coming weeks, Meta will shut down the Face
Recognition system on Facebook as part of a company-
wide move to limit the use of facial recognition in our
products. As part of this change, people who have opted
in to our Face Recognition setting will no longer be
automatically recognized in photos and videos, and we
will delete the facial recognition template used to identify
them.

The change will also affect Facebook’s “Automatic
Alt Text” feature, used by individuals with disabilities.
While the AAT program will still provide descriptions
of images and videos, it will not provide the name of
individuals in those images and videos.

Firefox 94 To Switch From GLX To EGL On Linux
Graphics Stack

You might not even notice it, but starting with Firefox
94, Mozilla will start switching from using GLX to
communicate with the Linux graphics stack to using
EGL. The former (GLX) is necessary under X11

(windowing manager), since the X11 implementation
of EGL isn’t as far along as it should be, according to
a Mozilla Graphics Team blog.

So what improvements should users see? Well, first
of all, EGL “speaks” much closer to the hardware.
I’m no graphics stack expert, but as best as I can
tell, GLX serves as the intermediary between
OpenGL and X11. This article on the HackADay
website has a great explanation. EGL has zero-copy
shared buffers and partial damage support. Partial
damage support means the whole window doesn’t
need to be redrawn if only a small part is changed,
saving power. Zero-copy shared buffers means
WebGL can be sandboxed rapidly.

The end user will see the following benefits, as
excerpted from the Mozilla blog:

So what exactly can you expect, and why? Mainly:

1. Improved WebGL performance. Thanks to
DMABUF zero-copy buffer sharing, WebGL can be
done both sandboxed and without round-trip to
system ram. WebGL is not only used in obvious
places such as games, but also in more subtle ways,
e.g. on Google Maps.

2. Reduced power consumption. With partial
damage we don’t need to redraw the whole window
any more if only a small part of the content changed.
Common examples here are small animations on
websites or when loading tabs.

3. Less bugs. EGL is more modern, much better
suited for complex hardware accelerated desktop
applications and used on more platforms, compared
to GLX.

4. Hardware video decoding by default is another
crucial step closer – in fact for most users it should
now be only one preference away (but beware, it still
has a couple of bugs).
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The HackADay article puts it into perspective:

Anecdotally, people who have tried it say the performance
gains have been stellar, particularly when watching
videos. The shared buffer helps as, for many GPUs, video
is decoded (converting the compressed stream like h.264
into a raw bitmap) and then composited. Having a shared
buffer and closer access to hardware allows the GPU to
transfer that decoded frame directly into the compositor
buffer, rather than making a trip to CPU RAM and back
out to the GPU for NUMA machines. Screenshot ShowcaseScreenshot Showcase
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compiled by Meemaw

Toddler Found Alive

A three-year-old who went missing in Texas in
October was found alive three days later, five miles
from his home, according to the Grimes County
Sheriff’s Office. Christopher’s mother and
grandmother were unloading their vehicle outside
their home when he disappeared, and a neighbor
reportedly saw him chasing a dog down the street.

People jumped into action, searching the
surrounding area, which is heavily wooded.
Volunteers commented that the trees were so thick
that it was difficult searching everywhere. Amazingly,
one of the volunteers found him three days later, and
he appeared to be well and unhurt. He was taken to
the local hospital and reunited with his family.

Driver Receives Citizen Hero Award

Amazon driver Tirek was given the Citizen Hero
Award in October from the Plano, Texas, Police
Chief for his heroic efforts after he witnessed a
rollover accident.

The rescue occurred in August in Plano, Texas,
when a car rolled over, which trapped the driver in
the car.

Tirek witnessed the crash while stopped at a red
light and “quickly moved his vehicle to block traffic to
protect the driver and the scene,” according to the
police department. “He then worked to free the
trapped individual from the car.”
The driver and Tirek both sustained injuries from the
crash. Tirek injured his hand while rescuing the
driver from the vehicle, according to the
department’s post. His quick action in placing his
vehicle as a roadblock helped avoid further injury to
the driver, and prevented anyone else from adding
to the crash. Plano Police awarded Tirek a Citizen
Hero Award for his efforts.

Adopted - Finally!

A two-year-old dog named Prudence has finally
found a family after spending almost half her life at
the SPCA Cincinnati animal shelter. The
organization recently announced a family adopted
the 55-pound canine following her 220 day stay at its
Ohio location.

“The queen has left the building!” the organization
announced in a Facebook post in October.

In advertising the dog’s availability, the shelter
commented that, “Prudence has a few
recommendations for her future family. She would
like to be the queen of the castle, have humans that
are willing to pamper her and receive a few chicken
snacks here and there.”

They believe that Prudence has finally found her
family.

Good Words, Good Deeds, Good News
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Heroic Firefighter Stops Suicide

First responders were called to a highway overpass
in Indiana, where a person was standing on the
ledge. One of the firefighters, Steve, grabbed the
person before they could jump off. The individual
was transported for additional professional care.

A Facebook post read, “Thank you for what you do! I
hope the person can get the help they need. Steve
you were the start of what they needed God bless
you!”

As a reminder, the US National Suicide Prevention
Hotline can be reached at 1-800-273-8255. The
hotline is available twenty-four hours a day, seven
days a week.

WWII Veteran Celebrates One Hundred Years!

A decorated World War II veteran partied for his
100th birthday on Saturday and was also gifted an
updated prosthetic leg.

The Western New York VA Medical Center
presented Navy veteran Bob Henneson with the leg.
He had lost his leg two years ago, many years after
being hurt when he was hit by a vehicle. He
exercised and got his body back in shape to be able
to upgrade to his bionic leg.

He explained he is young at heart and cannot wait to
get out and see the world.

“I’m 100 – I don’t feel any older than I did when I
was 90! I just feel great. I want to live, I want to go
out in civilization, see what Buffalo looks like now,”
he told a news outlet.

Bus Driver Finds Missing Boy

Ayden left his house in Clarksville, Tennessee at
approximately 9:15 p.m. on October 24th after
getting into trouble with his mother. Authorities
searched all night and even called in the Tennessee
Highway Patrol to help with the search. However it
was a local bus driver, Stephanie Dollich, out for her
regular route at 6:45 a.m. the next morning, who
found him.

“As I was going down the road, what I had seen off
in the distance had looked like a child to me walking
down the road. And so as I got closer, I pulled my
bus over and stopped my bus. And I noticed that it
was this little boy that was missing,” she recalled.

He was dressed only in a pair of shorts, so she
stopped the bus, wrapped him in a blanket and set
him inside the bus to warm up. Then she radioed her
dispatcher and told them she had found the missing
child. She has received much praise due to her
efforts to find the child.

“She is just the best of the best in terms of the
example that she’s setting for everybody,” DOE
Commissioner Penny Schwinn commented.

Dollich said, “Just to know he’s back home safe with
his parents, that feels great.”

Good Words, Good Deeds, Good News
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by CgBoy

FF Multi Converter is a useful application that
allows you to quickly and easily convert audio and
video files, images, and documents into different
formats. It relies on FFmpeg, ImageMagick, and
unoconv for converting files, and has support for
over 60 different media and document formats.

The interface is simple, but fairly well laid out and
easy to use. At the top of the screen is the list of files
that you’ve loaded in to be converted. You can
import files to convert by clicking the Add button, or
by simply dragging and dropping them into the box.
They will all be converted one at a time.

You’ll find all the audio and video conversion options
available from the Audio/Video tab in the middle of
the screen. From a drop-down menu, you can
choose from numerous common video and audio
formats to convert to, such as MP3, MP4, OGG, and
MKV, along with many more. You can then choose
the output video and audio codecs, of which you are
provided with many different options as well.

Alternatively, you can just use one of the many
presets FF Multi Converter comes with by hitting the
Preset button.

Clicking on More will reveal some advanced video
and audio conversion options. Here we can change
things such as the video resolution and aspect ratio,
video bitrate and framerate, audio bitrate and audio
channels, and video rotation. You can also load in a
subtitles file to embed into the video.

If you switch over to the Images tab, you’ll find all
the image conversion options. Here you can choose
the output image format, from the many available in
the drop-down menu, that you wish to convert the
image to. You can also change the image resolution
if you need to, as well as flip and rotate the image.

Lastly, we have the Documents tab. The only
conversion option we are given here is a drop-down
menu to select the desired format to convert your

document files to. Many common document formats
are available, such as DOCX, PDF, ODT, CSV, and
many more.

From the lower portion of the screen, you can
choose an output location for the converted files, or
choose to save them into the same folder as the
source files. You also have the option to remove the
original files after converting them. Finally, hit
Convert to begin converting all files you’ve loaded in.

Summary

All in all, FF Multi Converter provides a really quick
and easy way to convert any media or document
files you may need. I did not encounter any issues at
all when I used it. If you want a simple media
converter, and don’t need all the advanced features
of something like Handbrake, then FF Multi
Converter is a great choice.
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Serves 5
Unit converter

INGREDIENTS:

12-16 oz shrimp (fresh or frozen and thawed)
8 oz medium shell pasta
1 TBSP oil for sautéing (avocado, olive, coconut plus
extra as needed)
2 bell peppers
1 medium onion
3/4 tsp chili powder
/2 tsp cumin
1/2 tsp paprika
1/4 tsp garlic powder
1/4 tsp sea salt
1/8 tsp black pepper
1 cup enchilada sauce plus extra if desired

Tasty toppings

2-4 oz grated cheese (skip for dairy-free)
1 jalapeño, sliced thin
1/2 lime, cut into wedges
chopped green onion and/or cilantro to taste

Optional extras

guacamole or chopped/sliced avocado
a dollop of sour cream or Greek yogurt
pickled/marinated red onion
pico de gallo
hot sauce

DIRECTIONS:

If you plan on popping this bad boy in the oven to
melt the cheese, use an oven-safe pot/pan and
preheat your oven to 350F. Prefer to stir the cheese
into the pasta? Skip the oven!

Clean and peel shrimp, defrosting if needed. Lately
we've been buying frozen, deveined, easy-peel
shrimp. All I have to do is defrost, peel, and cook!
You can also buy your shrimp already peeled if you'd
like! Set shrimp aside and start on the pasta.

Cook pasta, uncovered in a large pot of boiling water
per package instructions. I like mine al dente. Rinse
in a colander with cold water. Drain and set aside

While your pasta boils, slice your bell pepper and
chop your onion. Bring a large high-sided pan or
skillet to medium-high heat with 1 TBSP of oil. Sauté

onion and peppers until edges are browned and
softened. Reduce heat to medium.

Pat shrimp dry and season with chili powder, cumin,
paprika, garlic powder, salt, and pepper. Mix well to
coat both sides.

Move veggies to the side, add a bit more oil, as
needed, and add your shrimp to the pan. Cook on

PCLinuxOS Recipe Corner Bonus

Tasty One-Pot Shrimp Fajita Pasta
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each side for about 2 minutes until shrimp curl and
become opaque. The cooking time will depend on
the heat setting you choose and the size of your
shrimp, but regardless they'll be perfectly cooked in
a matter of minutes. Add your cooked, drained pasta
and enchilada sauce. Gently fold everything
together. If you'd like, feel free to use additional
sauce! Sometimes I go light and other times I'll make
it extra saucy!

Add your cheese. You can swirl it into the pasta or
sprinkle on top and use an oven mitt to transfer the
pot to the oven, uncovered, for a few minutes until
hot and melty!

Now pile on the toppings! I added lime wedges (I
love to squeeze a little lime juice into the dish before
diving in) along with cilantro and fresh jalapeño's. It's
also amazing with a dollop of sour cream and some
salsa

NUTRITION:

Calories: 444 Carbs: 41g Fiber: 2g
Sodium: 1431mg Protein: 22g
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SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
tiles with which to make as long of a word
as you possibly can. Words are based on
the English language. Non-English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multiplier when tallying up your score.
Next, apply any additional scoring
multipliers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tiles in a set to
make your word. You will not necessarily
be able to use all seven (7) of the letters in
your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter tiles, here is a
list of how they are scored:

0 points: 2 blank tiles
1 point: E, A, I, O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z

6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to 12
minutes per letter tile set.
7. Have fun! It's only a game!

SUDOKU RULES: There is only one valid solution to each
Sudoku puzzle. The only way the puzzle can be considered
solved correctly is when all 81 boxes contain numbers and the
other Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be prefilled
for you. You cannot change these numbers in the course of the
game.

Each column must contain all of the numbers 1 through 9 and
no two numbers in the same column of a Sudoku puzzle can
be the same. Each row must contain all of the numbers 1
through 9 and no two numbers in the same row of a Sudoku
puzzle can be the same.

Each block must contain all of the numbers 1 through 9 and no
two numbers in the same block of a Sudoku puzzle can be the
same. D
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Possible score 274, average score 192.
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asymmetry bipyramid

cardioid circle

conic section crescent

cube cylinder

decagon dodecahedron

ellipse equilateral triangle

hexagon hexagonal prism

hexahedron icosahedron

line segment möbius strip

nonagon octagon

octahedron parabola

parallelogram pentagon

polygon polyhedra

prism pyramid

quadrilateral rectangle

rhombus sector

semicircle sphere

square symmetry

tesseract tetrahedron

trapezoid triangle

Download Puzzle Solutions Here
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G E S I H B S L F C B Q M M O L F X D Y O W E D Y F E Y F S
N O N W R H O M B U S G F R C Y H S Y R G H B X L H A H P C
A O M K G T R L X P E U E M T H F Y C A R D I O I D L W P O
I P G X T S S K O S Z C Y Z A E S D D M Q S E J N T Z Z T S
R P I A T X H S E L T Z Z Z H D K J O I Q C S L D L G B T M
T E O P X W G N U A P X I F E R Z Y I D S H M H E A Z E K H
L S L E C E I G N I W P R J D A C O B O E M C O R E T Y F V
A Q A L T L H G O U B S R A R W L Z U X X C H X L R K A X V
R U R G P B L U S I P O Z X O D R V A L I M A B A T L T D X
E A E N I E H A Z E O D M Q N B K G W J M E Y H I S O U N T
T R T A Q O E M A B L J I Y B I O N O E C M E H E N M V O B
A E A I D H C V M O Y X O M V N G R Y O V D U C N D U O G L
L I L R N E Q S B K G F W W A L Q N Q D R T T P G V R E A P
I G I T L X N V K F O Y U L I R O Y H O F O E P I L L O T P
U T R S P A J U E S N U P Z N N Y K N O R Q V I K C C H N A
Q K D D P H X A B N Z R I A A O U P H U A G J N R A V H E R
E Z A E E E S S S H I L G G M Z G H Y W G N M I E H I H P A
H C U O Z D P Y U S S N O R D E H A S O C I C V F K T X V L
S K Q Y Q R C M M N N N S B R A W X T E L L I P S E I X E L
D Q Z Z V O X M Y M O V P H O E T O M C F X S X S A D W L E
F J T J G N T E I T E G U S G I N Q T J O M R S X U K M F L
Q I H S O X F T V M Z T A A J D W U J P F A E B O D T L F O
A E G S K X Z R C G I E R C O H K T Y G R R W Y O R W J C G
B O I B L S U Y U Q G X B Y E K U C E E A I L Q O C K Z O R
L E E P A R A B O L A L F X Z D T P T C R E S C E N T W E A
V Q L J X H Z I D B J K B K M I Y V T H V L Y M D G N U S M
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1. A solid bounded by twenty sides or faces.

2. The intersection of a right circular cone and a plane.

3. In geometry, a solid having twelve faces.

4. A polygon with ten sides and ten angles.

5. A physical representation of a two-dimensional sheet

with only one surface.

6. An algebraic curve, so called from its resemblance to

a heart.

7. A solid bounded by eight faces.

8. A solid bounded by polygons.

9. A double-pyramid, made by joining a pyramid and its

mirror image base-to-base.

10. A quadrilateral having two parallel sides.

11. A polygon having four sides.

12. A three-sided regular polygon

13. A solid body having six faces; especially, a cube.

14. A solid figure enclosed or bounded by four triangles.

15. A prism with hexagonal base and top.
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